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Tanım

[image: image43.emf]Bu alıştırmada Betonarme Kutu Kirişli köprülerin analiz ve modellenmesi için SAP2000 programının sunduğu güçlü özelliklerden bazıları tanıtılacaktır. 

Modelini yaptığımız köprü 200 feet uzunluğunda ve iki açıklıklıdır. Köprü tabliyesinın (deck) genişliği 36 feet ‘tir ve derinliği parabolik olarak değişmektedir. Üzerinde her biri 14 feet genişliğinde olan iki trafik şeridini desteklemektedir. Betonarme kutu kesitli kirişliler üzerine öngerilme uygulanacaktır. Planda paralelkenar şeklindeki köprünün uç ve orta mesnetlerinde açı 15 derece olacaktır. 

Bilgisayar Modeli Tanımı

Yapıyla ilgili diğer parametreler aşağıdaki gibidir: 

Köprünün temiz açıklığı
= 200 ft

Tabliye Kutu Kesiti ortalama yüksekliği
= 5 ft

Tabliye Kutu Kesit genişliği, b
= 36 ft

Beton dayanımı, f 'c
= 4000 psi

Çelik akma gerilmesi, fy
= 60000 psi

Beton birim ağırlığı, Wc
= 150 pcf

Elastisite modülü, Ec
= 3600 ksi

Elastisite modülü, Es
= 29000 ksi

Poison oranı, v
= 0.2

Örnekte Ele Alınan Önemli SAP2000 Seçenekleri

· Köprü Analizi 

· Öngerme Tendonlarının (Prestress Tendons) kullanımı

· Tesir Çizgileri ve Yüzeyleri (Influence Lines and Surfaces)
· Hareketli Yük Katarları (Moving Loads)
Yöntem

Köprü Modeli Üretme Adımları

Köprü modelini üretmek için 12 adımdan oluşan bir dizi işlem uygulanmalıdır. Kullanıcı kendisine özgü bir köprü modeli oluşturmak için aşağıda listelenen adımları izlemeli ve aşağıdaki parametreleri kendi modeline uygun şekilde tanımlamalıdır: 

1. Yerleşim Çizgileri (Layout Lines)

2. Tabliye Kutu Kesiti (Deck Sections)

3. Köprü Kenar Ayakları (Abutments)

4. Orta Ayak Elevasyonu Hattı  (Bents).

5. Diyaframlar (Diaphragms)

6. Mafsallar (Hinges)

7. Parametrik Değişimler (Parametric Variations)

8. Köprü Nesnesi (Bridge Object) tanımları

9. Hazırlanmış olan modelin güncellenmesi (Update Linked Model) 

10. Trafik Şeritleri (Lanes)

11. Taşıtlar/Taşıt Sınıfları (Vehicles/Vehicle Classes)

12. Analiz Durumları (Analysis Cases)

Ön Hazırlık

İlk olarak File > New Model > Blank (Dosya > Yeni Model > Boş) komutunu kullanarak yeni bir model oluşturunuz. Birimlerin keep-feet ‘e ayarlı olduğundan emin olunuz.
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Köprü modülünün aktif olup olmadığını yukarıdaki ekrandaki Bridge Wizard (Köprü Sihirbazı) tuşunun aktif olmasından ya da SAP2000 ana ekranındaki Bridge (Köprü) menüsünün aktif olmasından anlayabilirsiniz. 
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Eğer köprü modülü aktif durumda değilse Options > Request Module License > Bridge Modeler (Seçenekler > Ek Modül Lisansı İste > Köprü Modelleyici) menüsünden SAP2000 Köprü modülü lisansınızı aktif hale getiriniz. 
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Aktif duruma gelmiyorsa ek köprü modülü lisansınız yok demektir.

Modelin Üretilmesi

Köprü Sihirbazı (Bridge Wizard)
Bu modeli oluşturmak için kullanacağımız komutların çoğu Bridge (Köprü) menüsü altında bulunmaktadır. Bridge Wizard (Köprü Sihirbazı) ‘da bu menü altındadır. Köprü sihirbazına bakarsanız, tüm adımların, işlemlerin basit bir açıklamasını görebilirsiniz. 
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Şekil 1 Bridge Wizard (Köprü Sihirbazı) Görünüşü

Adımları ilerledikçe, her adımla birlikte ilgili bir açıklama sağlanmaktadır. Gerekli olduğunda tanımla/değiştir (Modify/Show ...) komutlarıyla istenilen değerler değiştirilebilir. 
Biz bu örnekte modelimizi köprü sihirbazını kullanmadan, doğrudan Bridge (Köprü) menüsü altındaki komutlarla üreteceğiz. 

Genel Yerleşim Çizgileri (Layout Lines)
Bir köprü nesnesi oluşturulurken ilk adım yerleşim çizgisini  tanımlamaktır. Yerleşim çizgileri (layout lines) köprü nesneleri ve Trafik Şeritlerinin yatay ve düşey konumlarını tanımlarken referans çizgileri gibi kullanılır. Yerleşim çizgileri Kilometraj (station), planda paralelkenarlık açısı (bearing) ve meyil (grade) değerleriyle tanımlanır. Yatay ve düşey düzlemlerde düz, kavisli veya eğri olabilir.  Yatay eğriler dairesel (gerekirse spiral) ve düşey eğriler paraboliktir.

Köprümüzün hakim geometrisini belirleyen bir yerleşim çizgisi (layout line) tanımlamak için Bridge > Layout Lines > Add New Line (Köprü > Yerleşim Çizgileri > Yeni Yerleşim Çizgisi Ekle) formunu kullanıyoruz. Şekil 2 ‘ye bakınız. 

Bu formda; Starting Station (Kilometraj Başlangıcı) ‘u 0 feet ve End Station (Kilometraj Sonu) nu 220 feet olarak tanımlayacağız. Uçlardaki eğime yer sağlamak amacıyla yerleşim çizgisi gerçek köprüden küçük bir miktar daha uzun alınacaktır. Horizontal Layout Data (Yatay Yerleşim Bilgisi) altında, Quick Start (Hızlı Başlangıç) komutu kullanılarak yataydaki yerleşimin şeklini hızla tanımlayabiliriz. Bu örnek için Straight Line (Düz Çizgi) seçeneğini seçiniz. 
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Şekil 2 Bridge Layout Line Data (Köprü Genel Yerleşim Hattı Bilgisi)  Formu

Tabliye Kesiti Tanımı (Deck Section)
Yerleşim geometrisi tanımlandıktan sonraki adım köprü tabliyesinin kesitini tanımlamaktır. Köprü tabliyesiyle kullanmak üzere çeşitli parametrik köprü döşeme kesitleri mevcuttur. Bunlar; betonarme kutu (sandık) kirişler (concrete box girders), betonarme kiriş (concrete beam) ve çelik kiriş (steel beam) kesitleridir. Köprü tabliyesini tanımlamak için kullanacağımız Bridge Deck Section (Köprü Tabliyesi Kesiti) seçeneği de yine Bridge (Köprü) menüsü altında bulunmaktadır. 

Bridge menüsü > Bridge Deck Sections > Add New Section (Köprü > Köprü Tabliyesi Kesitleri > Yeni Kesit Ekle) komutunu kullanarak Select Bridge Deck Section Type (Köprü Tabliye Kesiti Tipini Seç) formunu görüntüleyiniz. Şekil 3 ‘de bu formda bulunan programa ait çeşitli parametrik şablonları görebilirsiniz. Biz bu örnekte Concrete Box Girders (Betonarme Kutu Kirişler) altında dikey kenarlı olan External Girders Vertical (Dış Kirişler Dikey) seçeneğini seçiyoruz. 
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Şekil 3 Köprü Tabliye Kesiti Tipi formu

Açılan Define Bridge Section Data (Köprü Kesit Bilgisi Tanımla) formunda toplam genişliğin (Total Width) 36 feet ve başlangıç yüksekliğinin (Total Depth) 5 feet olduğunu kontrol ediniz. Şekil 4 ‘e bakınız. 
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Şekil 4  Define Bridge Section Data (Köprü Kesit Bilgisi Tanımla) Formu

Köprü Nesneleri (Bridge Objects)
Köprü nesneleri menüsü, köprü modeli üzerinde çeşitli elemanları kontrollu olarak yerleştirmemizi sağlayan araçları barındırır.  Bu nedenle köprü nesnesi (bridge object) köprü modelleyicinin (bridge modeler) kalbidir. Köprü nesnesi aşağıdakileri içerir: 

a. Köprü açıklıkları (bridge spans) tanımlanır.

b. Her bir açıklığa köprü tabliyesi kesit özellikleri (deck section properties) atanır.

c. Açıklıklara tabliyelerin parametrik kesit değişimleri (parametric deck section variations) atanabilir.

d. Köprü Kenar Ayağı (abutment) özellikleri ve Verevlik Açısı (skews) atanır.

e. Orta Ayak Elevasyonu (bent) özellikleri ve Verevlikleri (skew)  atanır.

f. Mafsal (hinge) konumları, özellikleri ve Verevlikleri (skew)   atanır.

g. Dever Oranı – Yatay kurblarda merkezkaç kuvveti nedeniyle taşıtların dışarıya savrulmalarını önlemek için yol platformuna uygulanan enine eğimler (super elevations) atanır.

h. Öngerme Donatısı  (prestressed tendons) tanımlanır. (Bundan sonra tendon olarak kullanılacaktır).

Köprü açıklığı tanımlamak ve Kenar Ayağı verevliklerini atamak için Bridge > Bridge Objects > Add New Bridge Objects (Köprü > Köprü Nesneleri > Yeni Nesne Ekle) komutunu kullanacağız. 

İlk olarak köprü Kenar Ayağı (abutment) yerleşim çizgisinin uç noktasından 10 feet uzaklığa kaydırıyoruz, bunun için Define Bridge Object Reference Lines (Köprü Nesnesi Refererans Çizgileri Tanımla) alanında SpanStart satırının Kilometraj (station)  değerine 10 yazarak Modify (Değiştir) kutusuna tıklıyoruz. 

Daha sonra açıklık ismi (span label) kutusuna Span1, Kilometraj (station) kutusuna 110, öğe ismi (item label) kutusuna Bent yazıyoruz ve köprü nesnesi açıklık tipi (bridge object span type) kutusunda Span to Bent (Açıklıktan Orta Ayağa) seçeneğini seçiyoruz ve Insert Below Span kutusuna tıklıyoruz. Böylece orta noktaya bir Orta Ayak Elevasyonu (bent) eklenmiş oldu. En son olarak da, sondaki Kenar Ayağı (abutment) SpanEnd satırının Kilometraj (station) değerini 210 ile değiştirerek 10 feet kaydırıyoruz. 
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Şekil 5 Köprü Nesne Bilgisi formu

Köprü açıklıklarını tamamladıktan sonra Kenar Ayakları Hattını (abutments) ve Orta Ayak Elevasyonu  hattını (bent) 15 derece döndüreceğiz. Kenar Ayaklarını döndürmek için Modify/Show Abutments (Kenar Ayakları Düzenle/Göster) kutusunu tıklayıp Şekil 6 ’deki gibi Bearing (Açı) değerine Default-15 yazıp kapatıyoruz. 
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Şekil 6  Köprü Nesnesi Kenar Ayağı (Abutment) Tanımı

Şimdi de Orta Ayak Elevasyonu Hattını (Bent) döndürmek için Modify/Show Bents (Orta Ayak Elevasyonu Hattını Düzenle/Göster) kutusuna tıklayacağız. Bunun için Şekil 7 ’de göründüğü gibi Bearing (Açı) değerine de Default-15 yazarak kapatıyoruz. 
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Şekil 7 Köprü Nesnesi Orta Ayak Elevasyonu Hattı (Bent) Tanımı

Bu işlemden sonra Orta Ayak Elevasyonu Hattının 15 derece döndüğünü köprü nesnesi bilgi (bridge object data)  formundaki plan görünüşüne bakarak görebilirsiniz. Şekil 5 ‘e bakınız.

Bağlı Modelin Güncellenmesi (Update Linked Model)

Şu ana kadar tanımladığımız elemanlar köprü nesnesi tanımının parçalarıydı. Bu tanımları SAP2000’in  nesne tabanlı modeline çevirmemiz gereklidir, bunun için Bridge menüsü > Update Linked Bridge Model (Köprü > Bağlı Köprü Modelini Güncelle) komutunu kullanırız. 

Update Linked Model (Bağlı Modeli Güncelle) komutu köprü nesnesinden nesne-tabanlı SAP2000 modelini oluşturur. Eğer daha önceden bir nesne-tabanlı  köprü modeli mevcutsa bu silinir ve köprü nesnesinde en son yapılan değişiklikleri kullananan yeni bir nesne tabanlı  model oluşturulur. Bu bağımlı köprü modeli omurga (spine), alan (area) veya solid nesneleriyle oluşturabilir. 

Bağlı model güncellendiğinde, köprünün burgu modelleri (spine models), alan nesnesi modelleri ve solid nesnesi modelleri güncellenir. Köprü nesnesi tanımından oluşturulan nesne-tabanlı  model tipi istenildiği zaman değiştirilebilir. 

Bu örnekte alan nesnelerini kullanacağız. Bridge (Köprü) menüsü altında Update Linked Bridge Model (Bağlı Köprü Modelini Güncelle) seçeneğini seçiniz. Daha sonra Update as Area Object (Alan Nesnesi olarak Güncelle) seçeneğine tıklayınız. Şekil 8 ‘e bakınız.
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Şekil 8 Bağlı Köprü Modelini Güncelle formu

SAP2000 bizim köprü nesnesi modelimizi alıp, alan nesnelerinden oluşan bir yapı modeli üretti. Kenarlarda ve  ortada mesnetler de görülebilmektedir. Modeliniz Şekil 9 ‘daki gibi görünmelidir.
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Şekil 9 Nesne Tabanlı SAP2000 Modeli – Modelin mevcut görünümü

Köprü Kenar Ayakları (Abutments)

Köprünün uçlarındaki mesnetler için 'Kenar Ayakları' (abutment) tanımı kullanılır. 

Bu Kenar Ayağı tanımı (abutment definition), belirli bir Link/Mesnet Özelliği veya kullanıcı tarafından tanımlanan bir mesnet şartı olabilir.  Kullanıcı mesnet şartı, altı serbestlik derecesinin her birinin ankastre, serbest ya da bir yay sabitiyle birlikte tanımlanarak kısmi tutulu olmasına izin verir. 

Kenar Ayakları tanımında aynı zamanda uç mesnetlerin yataydaki konumları da belirlenir. Tek bir Kenar Ayağı mesnet referans çizgisinin üzerindedir. Birden fazla Kenar Ayağı durumunda kirişlerin altına ya da koprü genişliği boyunca eşit aralıklarla yerleştirilebilir.  

Kenar Ayakları’nda belirli kalınlıkta bir düşey perdenin de tanımlanması mümkündür.  Bu son kapatıcı perde sadece alan ve solid nesnelerin modellerine uygulanabilir. 

Kenar Ayaklarını düzenlemek için Bridge > Abutments > Modify/Show Bridge Abutments (Köprü > Kenar Ayakları > Kenar Ayaklarını Düzenle/Göster) komutunu kullanıyoruz. Bu örnek için Translation Normal to Abutment U2 (Öteleme Uç Mesnete Dik U2) seçeneğini Free (Serbest) yaparak köprümüzü bu yöndeki harekete serbest bırakacağız. Location of Abutment Supports (Uç Mesnetlerin Yataydaki Konumları) altında  At Every Girder Location  (Tüm Kiriş Yerlerinde) seçeneğini kullanarak köprünün tüm kirişlerde mesnetlenmesini sağlayacağız. Aynı zamanda Include Vertical Diaphragm seçeneğini de işaretleyerek Kenar Ayaklarda bir perde duvar (diyafram) tanımlayacağız. Şekil 10 ‘a bakınız. 
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Şekil 10 Köprü Kenar Ayağı (Abutment) Bilgisi

Orta Ayak Elevasyonu Hatları (Bents)

Orta Ayak Elevasyonu hattı  tanımı, geometriyi ve Elevasyon başlık kirişi (bent cap beam) ve Orta Ayak kolonlarının (bent columns) kesit özelliklerini belirtir. Aynı zamanda Orta Ayak kolonlarının taban mesnet şartlarını (base supports) da belirler. 

Orta Ayak kolonunun (bent column) belirlenen taban mesnet şartları Fixed (Ankastre), Pinned (Mafsallı) veya kullanıcı tanımlı bir kolon mesneti olabilir. Kullanıcının tanımladığı kolon mesneti belirli bir Link/Mesnet Özelliği veya kullanıcı tarafından tanımlanan bir mesnet şartı olabilir.  Kullanıcı mesnet şartı (user support condition), altı serbestlik derecesinin her birinin ankastre, serbest ya da bir yay sabitiyle birlikte tanımlanarak kısmi tutulu olmasına izin verir. Kullanıcı tanımlı kolon mesneti, Orta Ayak hattından (bent) ‘dan ayrı olarak tanımlanır. 

Orta Ayak Elevasyonu hattında (bent) aynı zamanda bir düşey perdenin de tanımlanması mümkündür. Tanımlanan diyafram sadece alan ve solid nesnelerin modellerine uygulanabilir. Spine (Burgu) tipi modellere uygulanamaz.  

Orta Ayak Elevasyonu (bent) tanımlandıktan sonra köprü nesnesi tanımının bir parçası olarak köprüye atanabilir

Orta Ayak hatlarını (bents) düzenlemek için Bridge > Bents > Modify/Show Bridge Bents (Köprü > Orta Ayak Elevasyonu > Elevasyon Hattını Düzenle/Göster) komutunu kullanacağız. Bu örnekteki Orta Ayak hattı (bent) için kolon sayısını (Number of Columns) 3 yapacağız.  Şekil 11 ‘e bakınız.  Modify/Show Column Data (Kolon Bilgisini Düzenle/Göster) komutuna tıklayıp kolon yerlerini kolon mesnet hattı boyunca 2.5, 15 ve 27.5 olarak değiştiriniz. Kolon yüksekliklerini de 24, 27 ve 30 olarak değiştiriniz. Şekil 12 ‘ye bakınız.
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Şekil 11  Köprü Orta Ayak Elevasyonu Hattı Bilgisi
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Şekil 12  Köprü Orta Ayak Elevasyonu Hattı (Bent) Kolon Bilgisi

Parametrik Değişimler (Parametric Variations)
Parametrik değişimler (parametric variations) köprü boyunca tabliye kesitindeki değişiklikleri tanımlar. Tabliye tanımında kullanılan herhangi bir parametre “değişken” bir şekilde tanımlanabilir. Bir veya birden fazla parametre aynı anda değişebilir. Tüm parametreler kendilerine özgü değişkenleri içerebilir. 
Bu örnekte parametrik değişim (parametric variation) köprü boyunca tabliye kesiti yüksekliği, kiriş ve döşeme kalınlıklarındaki değişimleri hesaba katmak için kullanılacaktır.  Değişimler lineer, parabolik veya dairesel olabilir. 

Bir değişim tanımlandıktan sonra köprü nesnesinde açıklıklara atanabilir. Bir değişim tanımlanırken atandığı köprü açıklığıyla aynı boyda tanımlanmalıdır. 

Bu aşamada, köprü tabliyesinin kesiti derinliği (deck depth) için parabolik bir değişim tanımlayacağız. Bunun için Bridge menüsü > Parametric Variations (Köprü > Parametric Değişimler) komutu kullanılacaktır. İki ayrı değişimimiz var. İlki sol açıklık için, ikincisi ise sağ açıklık için. Yükseklik toplamda 5 feet değişecek. Orta Ayak Elevasyonunda (bent) kenarlarda 10 feet ‘te sabit olacak. 

İlk değişim için Bridge menüsü > Parametric Variations > Add New Variation (Köprü > Parametric Değişimler > Yeni Değişim Ekle) formu altında, Quick Start (Hızlı Başlangıç) kutusuna tıklayınız ve Parabolic Linear değişimini seçiniz ve OK ‘e tıklayınız. Formu aşağıdaki Şekil 13 ‘de göründüğü gibi doldurunuz. 
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Şekil 13  İlk Açıklık için Parametrik Kesit Değişim Tanımı (PVAR1)

Daha sonra, yukarıdaki adımdan devam ederek 2. değişimi oluşturun. Define Variations (Değişkenleri Tanımla) iletişim kutusunda Add Copy of Variation (Değişimin Kopyasını Ekle) kutusuna tıklayınız. Quick Start (Hızlı Başlangıç) ‘a gidin ve Linear Parabolic seçeneğine tıklayın (bir önceki değişimin tam tersi). İsmi PVAR2 olacaktır, Distance (Mesafe) ve Dimension Change (Ölçü Değişimi) değerlerini Şekil 14 ‘de görüldüğü gibi değiştiriniz. 
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Şekil 14  İkinci açıklık için Parametrik Kesit Değişimi Tanımı (PVAR2)

Değişimler tanımlandıktan sonra, onları Bridge > Bridge Objects (Köprü > Köprü Nesneleri)  komutunu kullanarak açıklıklara atamalıyız. Bridge Object Data (Köprü Nesnesi Bilgisi) formu altında Modify/Show Spans (Açıklıkları Düzenle/Göster)  kutusuna tıklayarak kesitleri sabitten değişkene çevirebiliriz. Bu iletişim kusunda, Açıklık 1 (Span 1) için,  Span Varies (Açıklık Değişiyor) kutusu üzerine çift tıklayınız. (Şekil 17) Bir köprü kesit değişimi (bridge section variation) formu açılacaktır. Total Depth (Toplam Yükseklik) seçeneği için Variation (Değişim) kutusuna çift tıklayınız ve PVAR1 ‘i seçiniz ve OK ‘e tıklayınız.  Şekil 15 ‘e bakınız. 
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Şekil 15  Köprü Kesit Değişimi Tanımı Formu (Span1)

Bir sonraki açıklık için aynını tekrarlayınız fakat bu kez Variation (Değişim) olarak PVAR2 ‘yi seçiniz. Şekil 16 ‘ya bakınız. Yükseklikteki değişim Şekil 18 ‘den görülebilir.
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Şekil 16  Köprü Kesit Değişimi Tanımı Formu (SpanToEnd)
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Şekil 17  Parametrik Değişim Tanımı
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Şekil 18  Köprü kesitindeki parametrik değişim görünüşü

Öngerme Yükü Durumu (Prestressed Load Case)

Bu aşamada, ilk olarak öngermeli yük durumu oluşturacağız. Bunun için, Define > Static Load Cases iletişim kutusuna gidiniz. Şekil 19 ‘a bakınız.
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Şekil 19 Yük Tanımları

Daha sonra, Bridge Objects  (Köprü Nesneleri) formundan Öngerme tendonlarını tanımlayacağız. Bridge > Bridge Object > Modify/Show Bridge Object Data > Modify/Show Bridge Prestress (Köprü > Köprü Nesneleri > Köprü Nesne Verisi Düzenle/Göster > Köprü Öngermesini Düzenle/Göster) komutu yeni bir tendon eklememize olanak verir. Tüm köprü boyunca uzanan art germeli tendonlar ekleyeceğiz. Tendonların alanı 10 inç2 ve tendon kuvveti 1500 kips olacak. Bunun için; Modify/Show Bridge Prestress (Köprü Öngermesini Düzenle/Göster) kutusuna tıkladıkdan sonra Add New Tendon (Yeni Tendon Ekle) ‘yi seçiniz. Tendon alanı (tendon area) 10 in2 ve tendon yükünü (tendon load) 1500 kips olarak doldurunuz. Tendon Load Case (Tendon Yük Durumu) alanında PRESTRESS (Öngerme) yük durumunu seçiniz. Şekil 20 ‘ye bakınız.

Düşey yerleşim (vertical layout) için Quick Start (Hızlı Başla) kutusuna tıklayınız, Parabolic Tendon 1 seçeneğini seçiniz. Ön tanımlı değerleri kabul edeceğiz. 
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Şekil 20  Köprü Tendon Bilgisi formu

Daha sonra, tanımlanan bu tendonu tüm diğer kirişler üzerine kopyalayacağız. Bunun için, Define Prestress Tendons (Öngerme Tendonları Tanımla) formunda Copy to All Girders (Tüm Kirişlere Kopyala) seçeneği üzerine tıklayınız, böylece toplam 4 tendon oluşacaktır. Eğer Show All Tendons (Tüm Tendonları Göster) kutusuna tıklarsak, kesit görünüşü üzerinde tendonların açıklık boyunca nasıl değiştiğini görebiliriz (Şekil 21). 

Eğer View menüsü > Set Display Options (Görünüş > Görüntü Seçeneklerini Değiştir) formunda Areas (Alanlar) altında Not in View (Görünüşte Yok) seçeğini işaretleyerek alan nesnelerini görünüşten kaldırırsanız, tüm Öngerme tendonlarının yeri görülebilir. Şekil 22 ‘ye bakınız. 
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Şekil 21 Köprü Tendon Yerleşim Görünüşü
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Şekil 22 Öngerme tendonları 3D görünüşü

Hareketli Katar Yükleri (Moving Loads)

SAP2000 ‘de taşıt yükleri yapıya Trafik Şeritleri aracılığıyla aktarılır. Bu nedenle eğer köprünüzü hareketli taşıt yüklerine göre analiz etmek istiyorsak Trafik Şeritlerini tanımlamalıyız. Trafik Şeritleri (lanes) yerleşim çizgilerine veya mevcut olan çubuk nesnelerine referans alınarak tanımlanabilir. Tek bir Trafik Şeridi, bir veya birden fazla yerleşim çizgisine veya bir ya da daha fazla çubuk nesnesinden referans alabilir fakat hem yerleşim çizgisi ve hem de çubuk nesnelerinden aynı anda referans alamaz. Trafik Şeritleri istendiğinde bir genişliği olacak şekilde tanımlanabilir. Trafik Şeritleri hareketli katar yükü (moving load) tipi analiz durumlarında veya statik ve dinamik çok adımlı (multi-step) analiz durumlarında kullanılan hareketli katar tipi yük durumlarında kullanılabilir.

Bu örnekte yükleri tanımlamak için ilk olarak, Bridge > Lanes (Köprü > Trafik Şeritleri) komutunu kullanarak iki Trafik Şeridi tanımlamalıyız. Modelimizi bir yerleşim çizgisinden (layout line) oluşturmuştuk, bu nedenle Trafik Şeridi tanımlarken de aynı yerleşim çizgisini kullanacağız. Açılan Define Lanes (Trafik Şeridi Tanımla) formunda Add New Lane Defined from Layout Lines (Yerleşim Çizgilerinden Yeni Trafik Şeridi Ekle) kutusuna tıklıyoruz. İlk Trafik Şeridimizin eksenden uzaklığı (centerline offset) -9 feet ve tüm şerit genişliği (lane width) 14 feet olacaktır. Kolay görünmesi için rengini kırmızıya çeviriyoruz. İlk şerit çizgisinin yerleşim çizgisine bağlı olduğu görülebilir. Formu Şekil 23 ‘deki gibi doldurunuz ve kapatınız.
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Şekil 23  Köprü Trafik Şeridi Bilgisi
İkinci şeritimiz yerleşim çizgisinin diğer tarafında ve eksenden uzaklığı 9 feet olacaktır. Define Lanes (Trafik Şeridi Tanımla) formunda ürettiğimiz ilk şeriti kopyalamak için Add Copy of Lane (Trafik Şeridinin Kopyasını Ekle) kutusuna tıklayınız ve Change Ofset by Specified Amount (Ofseti Belirli Miktarda Değiştir) kutusuna 18 ft yazarak ikinci şeridi oluşturuyoruz. Şekil 24 ‘e bakınız.  
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Şekil 24  Şeridi Taşı formu

Trafik Şeritleri tanımlandıktan sonra,  Display > Show Lanes komutuna gidip, Show Lane Width seçeneğini işaretlersek görünüş üzerinde şerit genişliğini görebiliriz. Modeliniz Şekil 25 ‘deki gibi görünmelidir. 
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Şekil 25   Trafik Şeritlerinin 3D görünüşü

Eğer hareketli katar yükünü (moving load) analizde kullanmak istiyorsanız taşıt sınıflarını (vehicle class) da tanımlamalısınız. Taşıt sınıfı (vehicle class) bir hareketli katar yükü analizinin yapılacağı (her defasında bir taşıt) bir ya da daha fazla taşıttan oluşturulan bir gruptur. 

Programda yerleşik olarak çok sayıda standart taşıt tanımı yapılmıştır.  Ek olarak kendi taşıt tanımınızı oluşturmak için General Vehicle (Genel Taşıt) özelliği vardır. Tüm taşıt tanımları bir ya da birden çok  tekil ve/veya düzgün yayılı yükten oluşur. 

Trafik Şeridi üzerinde hareket edecek olan taşıtları Bridge menüsü > Vehicles (Köprü > Taşıtlar) komutuyla tanımlayacağız. Bu örnek için HS20-44 standart taşıtını kullanacağız. Define Vehicles (Taşıt Tanımla) formunda Add Vehicle (Taşıt Ekle) kutusuna tıklayınız ve açılan formu  Şekil 26 ’daki gibi doldurunuz. 
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Şekil 26  Standart Taşıt Bilgisi   

Bir sonraki aşama da da bu tanımlanan taşıtları Bridge menüsü > Vehicle Class (Köprü > Taşıt Sınıfı) komutuyla bir taşıt sınıfına atamalıyız. Taşıt sınıfları bir yada daha fazla sayıdaki taşıtı bir arada gruplamanıza olanak verir. Define Vehicle Classes (Taşıt Sınıfı Tanımla) formunda Add New Class (Yeni Sınıf Ekle) kutusuna tıklayınız ve açılan formu Şekil 27 ‘deki gibi doldurunuz.
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Şekil 27   Taşıt Sınıfı Bilgisi

Analiz Durumları (Analysis Cases)
Köprünüzün analizini yaparken herhangi bir analiz durumu tipi kullanılabilmesine rağmen, taşıt hareketli yüklerine özel bir kaç çeşit analiz seçeneği vardır. 

Hareketli katar yükü analiz durumları (moving load analysis cases) farklı değerler için tesir çizgilerini hesaplar ve maksimum ve minimum tepki değerlerini elde etmek için şerit yüklerinin tüm permütasyonlarını çözer. 

Çok-adımlı statik ve çok-adımlı dinamik (doğrudan integrasyon zaman alanı) analiz durumları (multi-step static ve multi-step dynamic analysis cases) bir ya da birden fazla taşıtın köprü üzerinde belirli bir hızda hareket ettiği durumu analiz etmede kullanılır. Bu çok-adımlı analiz durumları özel hareketli katar yük durumu tipleriyle tanımlanır. Bunlar da Trafik Şeritleri üzerinde hareket eden taşıtların doğrultusu (direction), başlangıç zamanı (starting time) ve hızlarıyla (speed) tanımlanır. 

Trafik Şeritleri ve taşıtları oluşturmayı tamamladıktan sonra bir hareketli katar yükü analiz durumunu oluşturacağız. Yeni analiz durumu bir hareketli katar yükü olacak (moving load) ve üzerinde Trafik Şeritleri üzerine 1 ölçeğiyle uyguladığımız taşıt sınıfı olacak. 

Define menüsü > Analysis Cases (Tanımla > Analiz Durumları) formunda Add New Case (Yeni Durum Ekle) kutusuna tıklayınız. Açılan formda Analysis Case Type (Analiz Durumu Tipi) altında, Moving Load (Hareketli Katar Yükü) seçeneğini seçiniz ve VECL1 taşıt tipini ekleyiniz ve OK ‘e tıklayınız. Şekil 28 ‘e bakınız. 

[image: image33.png]Analysis Case Data - Moving Load

Anslsis Case Type
Analysis Case Name [5CASET SetDef Name Moving Load
Stifness to se MulLane Scale Factors
& Zero Il Condiions - Unstiessed State: Numberof ~ Reduction
Lanes ol Factar
@ |l

Losced [

e

Loads Applied

Lanes Loaded for Assignment 1
Min  Max
Vehicle  ScaleFactor Loaded  Loaded Litof Defined Selected
Assign __Class Lanes  Lanes  Lanes Lanes Lanes
Nimber ey ][y [ [ Loaded S
T [VECD 7 0 0 Al LANE2
Add Modiy Delete < Remove

oK

Cancel





Şekil 28 Hareketli Yük Katarı Analiz Durumu

Analiz

Analizi çalıştırmadan önce Bridge menüsü > Bridge Responses (Köprü > Köprü Hesap Seçenekleri) seçeneği altından Section Cuts (Çoklu Kesitler) seçeneğini kapatıyoruz. Artık analizi çalıştırabiliriz. 

Analizin tamamlanmasından hemen sonra ölü yük durumu altındaki şekil değiştirmiş hal gösterilir. Diğer analiz durumları için şekil değiştirmiş hale Display > Show Deformed Shape komutundan ulaşılır. Öngerme yük durumunun şekil değiştirmiş halinin yukarı doğrultuda olduğuna dikkat ediniz, bu beklenen bir durumdur. 
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Şekil 29  Öngerme (PRESTRESS) yük durumunu için şekil değiştirmiş hal

Tesir çizgileri (influence lines) yapıda tanımlanan bir köprü şeridi üzerindeki birim yükün düğüm noktası, çubuk, kabuk, düzlem, solid ve link elemanlarda meydana getirdiği çeşitli deplasman, reaksiyon, kuvvet, moment, kesme kuvvetleri, burulma veya eksenel kuvvetler için gösterilebilir. 

Trafik Şeritleri tanımlandıktan ve bir hareketli katar yük durumu oluşturulup çalıştırıldıktan sonra, bir kolon seçiniz ve  Display menüsü > Show Influence Lines/Surfaces (Görüntüle > Tesir Çizgileri/Yüzeylerini Göster) komutunu vererek Show Influence Lines/Surfaces fomunu görüntüleyiniz. Şekil 30 ‘a  bakınız. 
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Şekil 30   Kutu Kesitli Döşemede Tesir Çizgileri

Herhangi bir yük durumu için köprüdeki kuvvet ve gerilme değerlerini görebilirsiniz. Display > Show Bridge Forces/Stress  (Görüntüle > Köprü Kuvvetleri/Gerilmelerini Göster) komutuna giderek Bridge Object Response Display (Köprü Nesnesi Tepki Görünüşü) formunu görüntüleyiniz. Gerilme (stress) seçeneğine tıklayınız, öngerilmenin verildiği yük durumunu ve Longitudinal Stress – Top and Bottom Right – S11 (Boyuna Doğrultuda Gerilme – Üst ve Sağ Alt – S11) seçeneğini seçiniz. Şekil 31 ’deki görünüşe bakınız. 
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Şekil 31  Köprü Nesnesi Tepki Görünüşü

Kamyonlara ait yeni bir hareketli katar yük durumu eklemek için modelin kilidini kaldırıyoruz. Define > Load Cases (Tanımla > Yük Durumları) komutu altında TRUCKS isminde, Moving Load tipinde bir yük durumu ekleyeceğiz. Şekil 32 ‘ye bakınız. 
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Şekil 32  Yükleri Tanımla formıu

Burada, Modify Moving Load (Hareketli Yük Değiştir) komutu yük şablonu tanımlamamıza olanak verir. Köprüyü üç kamyonla yükleyeceğiz. İlki Şerit 1 ‘de 40 feet/sn hızında hareket edecek. İkinci kamyon, Şerit 2 ‘de köprünün diğer ucundan 40 feet/sn hızında başlayacak. Üçüncü kamyon ise, Şerit 1 üzerinde ilk kamyonun 1.5 saniye arkasından gidecek. Toplam yükleme süresini 7.5 saniye olarak alacağız ve 0.3 saniye aralıklarla ifade edeceğiz. Şekil 33 ‘e bakınız.
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Şekil 33  Çok Adımlı Hareketli Katar Yükü Oluşturulması

Bir kez daha analizi çalıştırabiliriz. Fakat bu kez sedece TRUCKS durumuyla ilgileniyoruz,  bu nedenle diğer analiz durumlarını tekrar çalıştırmamıza gerek yok.  

Display  > Show Bridge Forces/Stresses komutunu kullanarak TRUCKS analiz durumu için köprü kuvvetlerini görüntüleyebiliriz. 
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Şekil 34  Köprü Nesnesi Tepki Görünüşü

Display > Show Forces/Stresses > Shells (Göster > Kuvvet/Gerilmeleri Göster > Kabuklar)  komutuyla köprü tabliyesini oluşturan kabuk elemanlar üzerindeki kuvvetleri de görmemiz mümkündür.  Şekil 35 ‘de analizin ortasına en yakın olan Adım 9 için F11 kuvvet birleşeni görülmektedir. 
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Şekil 35   9. adımında kamyon (TRUCKS) yük durumunu için F11 kabuk kuvveti

Son olarak View > menüsü Create OpenGL View (Görünüş > OpenGL Görünüşü Üret) komutuyla OpenGL görünüşüne geçip araç çubuğunda Play Animation komutuna tıklarsanız (yada File menüsü > Create Video > Create Multi-step Animation Video komutu), kamyonları köprü üzerinde hareket ederken görüntüleyebiliriz. Multi-step Video File Creation (Çok Adımlı Video Dosyası Oluşturma) formunda, TRUCKS analiz durumunun seçili olduğuna emin olun ve büyütme çarpanını (magnification factor) deplasmanların görülebilmesi 2000 ‘e yükseltin. Show Vehicles (Taşıtları Göster) seçneğini seçili duruma getirin. Şekil 36 ‘ya bakınız. Video dosyasının oluşturulmasını adım adım görebilirsiniz. Video bir kez oluşturulduktan sonra, video dosyası sürekli tekrarlanacaktır.  

[image: image41.png]i-step Video File Creation

AviFile Name Browse.

[ecanputers and

Flot Type
& Anslysis Resuls !

Anslysis Case Data

Case Name Start Step i
TRUCKS EndStep %
Step Increment i

Diply Opins
I WieFiane  Magrifeaion Factor [2000
I~ Cubic Cuve v i Vahides
I~ Absolte Displacemerts [~ SwitchVeick Draw Oder

A Optons
FamesperSecond |4
FrameSize piels) 540 by [0

" ey





Şekil 36   Çok Adımlı Video Dosyası Oluşturma formu
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Şekil 37  Çok-adımlı video dosyasından görünüş
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